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1 Test Plan

1.1 Introduction

During each test period of the SPLAT development cycle, the test procedures defined bel ow will
be used to evaluate the SPLAT software. Note that each Test Case is based on functionality
identified in the SPLAT Requirements, Architecture, or Design Documents. The test cases are
marked in turn are for the applicability to either Build | or Build Il development in the
Reguirements document and Build 111, the first operational release of the tool.. The next section
contains a check list to be used in testing.
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SPLAT Test Check List

Directions: Review each test case. If testing is not appropriate, simply write “N/A” in the
Comments section. For example, during Buildl testing, all Build Il Test Cases should be marked
“N/A”.

Test | Build | Pass | Fail | Tested | Comments
Case By
1 1,2
2 1,2
3 1,2
4 1.2
5 1,2
6 1,23
7 1,2
8 2
9 2
10 1,2
11 1.2
12 1,2
13 1,2
14 1,2
15 1,2
16 1,2
17 3
18 3
19 3
The test procedures were completed on using Build of SPLAT.
Signature
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2 Test Procedures

The Test Casesin Section 2 correspond to Use Cases and exercise the functionality of the
SPLAT tool. Note that following test data sets will be used to validate the operation of the
SPLAT tool. With the exception of the ASTER test, all of the test scenarios represent actual
events and were provided by the Terra FOT.

Roll Maneuver for day 180 of 2002.

Roll Maneuver for day 210 of 2002.
DMU event for day 219 of 2002.

ASTER test scenario (Aquilent generated)

poODNPRE

2.1 Test Case: 1 Parse Input Reports

2.11 Relevant Builds
This test case appliesto Builds | and I1.

2.1.2 Test Information

Goal in Context: The Operator selects the Create Contact List button from the main
viewer tool bar.

Pre-conditions: Scheduling Options and Input Reports have been specified.

Success End Condition: Events are extracted from the input reports and displayed on the
main timeline.

Failed End Condition: Timeline remains empty and system displays an error dialog
indicating problem encountered.

Primary Actor: Operator

2.1.3 Test Scenario

The following variations must be addressed:
1. Manua Aster Modeling with no Ground Contacts

Select the “ Edit Scheduling Options” option from the tool bar.
Enter the Plan Start, Plans Stop, and Sync Point Offset

Select Manual Aster Modeling mode.

Specify amodeling percentage for Aster (0-100).

Select the “ Select Reports” button.
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Provide entries for the TDRS Report, Orbital Events Report, and the SSR Buffer
States Report.

Select the “ Ok” button on the Input Reports Ul. Verify that the dialog is dismissed
and no error dialog is displayed. Not specifying a needed report will cause an error
dialog.

Select the “ Save” button on the Scheduling Options Ul.

Select the Create Contact List option from the tool bar.

Review the events on the timeline to make sure all selected events are present and
that they fall within the specified plan horizon.

Open the Synchronization Selection Dialog and make sure all buffer state entries for
the sync point offset window are present.

2. Automated Aster Modeling with no Ground Contacts

Select the “Edit Scheduling Options’ option from the tool bar.

Enter the Plan Start, Plans Stop, and Sync Point Offset

Select Automated Aster Modeling mode.

Select the “ Select Reports” button.

Provide entries for the ATC Load Report, TDRS Report, Orbital Events Report, and
the SSR Buffer States Report

Select the Create Contact List option from the tool bar.

Select the “ Ok” button on the Input Reports Ul. Verify that the dialog is dismissed
and no error dialog is displayed. Not specifying a needed report will cause an error
diaog.

Select the “ Save” button on the Scheduling Options Ul.

Review the events on the timeline to make sure they fall within the specified plan
horizon and that the ASTER RTCS s present in the ATC Load Report are on the
timeline.

Open the Synchronization Selection Dialog and make sure all buffer state entries for
the sync point offset window are present.

3. Manual Aster Modeling with Ground Contacts

Select the “ Edit Scheduling Options” option from the tool bar.

Enter the Plan Start, Plans Stop, and Sync Point Offset

Select Manual Aster Modeling mode.

Specify amodeling percentage for Aster (0-100).

Select the “ Select Reports” button.

Provide entries for the TDRS Report, Orbital Events Report, the SSR Buffer States
Report, and the GN Report.

Select the “ Ok” button on the Input Reports Ul. Verify that the dialog is dismissed
and no error dialog is displayed. Not specifying a needed report will cause an error
dialog.

Select the “ Save” button on the Scheduling Options Ul.

Select the Create Contact List option from the tool bar.
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Review the events on the timeline to make sure they fall within the specified plan
horizon.

Open the Synchronization Selection Dialog and make sure all buffer state entries for
the sync point offset window are present.

4. Automated Aster Modeling with Ground Contacts

Select the “ Edit Scheduling Options” option from the tool bar.

Enter the Plan Start, Plans Stop, and Sync Point Offset

Select Automated Aster Modeling mode.

Select the “ Select Reports’ button.

Provide entries for the ATC Load Report, Integrated Report, Orbital Events Report,
the SSR Buffer States Report, and the GN Report,

Select the “ Ok” button on the Input Reports Ul. Verify that the dialog is dismissed
and no error dialog is displayed. Not specifying a needed report will cause an error
diaog.

Select the “ Save” button on the Scheduling Options Ul.

Select the Create Contact List option from the tool bar.

Review the events on the timeline to make sure they fall within the specified plan
horizon and that ASTER RTCS s from the ATC Load report are on the timeline.
Open the Synchronization Selection Dialog and make sure all buffer state entries for
the sync point offset window are present.

2.2 Test Case: 2 Specifying Scheduling Options
2.2.1 Relevant Builds

This test case appliesto Builds | and 1

2.2.2 Test Information

Goal in Context: Operator enters the options needed from schedul e generation.

Success End Condition: A valid set of scheduling optionsis selected.

Failed End Condition: The scheduling options dialog remains active and adialog box is
displayed containing the error condition.

Primary Actor: Operator

2.2.3 Test Scenario

The following variations must be addressed:

1. Manua Aster Modeling
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Select the “Edit Scheduling Options’ operation from the tool bar.

Enter the plan start time (e.g. 2002/180/11:30:00)

Enter the plan stop time (e.g. 2002/180/15:55:00)

Enter the sync point offset (e.g. 02:30. Specified as hours and minutes)

Select the Manual ASTER Modeling Mode.

Specify an Aster modeling percentage (0-100).

Select the Reports Location option and choose either Local or MMS. Observe that
selection of the MM S option should result in an information dialog raised to indicate that
the connection to MMS is a future enhancement.

Select the Local Reports Option and select the Specify Reports option.

A dialog will be raised for specifying input reports.

Browse to the correct directory and locate the TDRS Report, the SSR Buffer States
Reports, and the AM1 Orbital Events. No entry isrequired for the GN Report unless
Ground Contacts are needed.

Select the “ Ok” button and the dialog is dismissed.

Select the “ Save” button on the Scheduling Options Ul and the values are checked for
validity. Verify that the dialog is dismissed and no error dialog is displayed.

2. Automated Aster Modeling

2.3

231

Select the “Edit Scheduling Options’ operation from the tool bar.

Enter the plan start time (e.g. 2002/180/11:30:00)

Enter the plan stop time (e.g. 2002/180/15:55:00)

Enter the sync point offset (e.g. 02:30. Specified as hours and minutes)

Select the Automatic ASTER Modeling Mode (Automatic or Manual). Observe that the
ASTER modeling percentage field is disabled.

Select the Reports Location option and choose either Local or MMS. Observe that
selection of the MM S option should result in an information dialog raised to indicate that
the connection to MMS is a future enhancement.

Select the Local Reports Option and select the Specify Reports option.

A dialog will be raised for specifying input reports.

Browse to the correct directory and locate the ATC Load Report, TDRS Report, the SSR
Buffer States Reports, and the AM1 Orbital Events. No entry is required for the GN
Report unless Ground Contacts are needed.

Select the “ Ok” button and the dialog is dismissed.

Select the Save button on the Scheduling Options Ul and the values are checked for
validity. Verify that the dialog is dismissed and no error dialog is displayed.

Test Case: 3 Adding a Dump Window to a Contact

Relevant Builds

Thistest caseis applicableto Builds | and 11.
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2.3.2 Test Information

Goal in Context: Operator selects the Add button for one of the K or X band
contacts on the timeline.
Preconditions: A schedule with aminimum of X or K band contact is displayed

on thetimeline.
Success End Condition: A new dump window is added to the contact period.
Failed End Condition: An error dialog is displayed describing the problem.
Primary Actor: Operator

2.3.3 Test Scenario

=

Select the “ Add” button for one of the K or X band contacts

2. Inthediaog specify the start and stop of the playback, the location (AOS or LOS), and the
maximum dump percentages for the MODIS, MISR and ASTER buffers.

Verify that omitting any entry will result in an error dialog being displayed on save.

Also very that dump percentages < 0 or > 100 will result in error on save.

Verify that entering a stop time or end time outside of the parent contact will result in an
error dialog on save.

6. Verify that the dump window is displayed on the timeline when the data specified is valid.

gk w

24 Test Case: 4 Edit an Existing Dump Window

2.4.1 Relevant Builds

Thistest caseis applicable to Builds | and Il

2.4.2 Test Information

Goal in Context: Operator Selects the Edit Button for one of the dump windows on
the timeline

Preconditions: A valid schedule with one or more dump windows is visible on the
timeline.

Success End Condition: A modified dump window is displayed on the timeline

Failed End Condition: An error dialog is raised describing the error.

Primary Actor: Operator

2.4.3 Test Scenario

1. Select the “Edit” button for one of the dump windows on the timeline.
2. Veify that adialog box israised containing the selected dump window settings.
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3. Modify one or more of the dump window settings (start, stop, max dump percentages).
Verify that incorrect entries result in an error dialog being displayed.

4. Select the “Save” option and verify that dialog is dismissed and the modified dump window
isdisplayed on the timeline.

5. Verify that any playbacksin the modified dump window have been removed from the
timeline. [Valid on for builds | and Il. For Build 111 and beyond modifications to dump
windows or sync points causes an automatic schedul e regeneration. See test case 19].

2.5 Test Case: 5 Delete an Existing Dump Window

2.5.1 Relevant Builds
Thistest caseisrelevant to Builds | and I1.
2.5.2 Test Information

Goal in Context: The Operator removes a dump window from the schedule.

Preconditions: A valid schedule with one or more dump windows must be present
and visible on the timeline.

Success End Condition: The schedule with the dump window removed

Failed End Condition: The dump window is not removed and an error dialog is displayed.

Primary Actor: Operator

2.5.3 Test Scenario

Select the “Edit” button for one of the dump windows on the timeline.

Verify that the raised dialog contains the selected dump window information.

Select the “Delete” button.

Verify that the dialog box is dismissed and the dump window is removed from the timeline.

el RN

2.6 Test Case: 6 Select Synchronization Point

26.1 Relevant Builds
This test case appliesto Builds | and I1.

2.6.2 Test Information

Goal in Context: Operator selects a different synchronization point than the one
selected by the tool.
Preconditions: The contact list must have been created and the scheduling options
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specified.

Success End Condition: A new synchronization point is selected and displayed on the
timeline

Failed End Condition: An error dialog is raised indicating the error

Primary Actor: Operator

2.6.3 Test Scenario

Select the “ Select Synchronization Point” option from the tool bar.
Click the radio button next to the desired sync point to select it.
Select the “ Save” Option.
Verify that awarning dialog is raised notifying the operator that selecting a new sync point
requires the schedule be re-generated.
Verify the following:
a. The synchronization point changes on the timeline.
b. Dump windows are added/removed depending on the selected sync point.
c. Playback windows for existing dump windows are removed. [Valid on for builds |
and I1. For Build 111 and beyond modifications to dump windows or sync points
causes an automatic schedule regeneration. See test case 19].

el SR N

o

2.7 Test Case: 7 Main Window

2.7.1 Relevant Builds
Thistest caseis applicable to Builds | and I1.

2.7.2 Test Information

Goal in Context: The Operator starts SPLAT.
Preconditions: A functioning computer which supports Java 2; correct installation
of SPLAT.

Success End Condition: The operator sees a splash window identifying the SPLAT product
followed by the display of the SPLAT main window.

Failed end conditions: The main window failsto be displayed or afatal exceptionis
thrown.
Primary Actor: Operator

2.7.3 Test Scenario

1. The SPLAT Main Window is displayed and is ready for operator input/schedule generation.
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2.8 Test Case: 8 Automated Dump Window Determination

281 Relevant Builds
Thistest caseis applicable to Build Il only.

2.8.2 Test Information

Goal in Context: The operator selects the “ Create Contact List” and the tool
determines the appropriate locations for an initial set of dump
windows.

Preconditions: SPLAT isexecuting and valid scheduling options have been
entered.

Success End Condition: A parsed schedule is displayed containing an initial set of dump
windows
determined by the tool.

Failed end condition: No schedule is displayed.

Primary Actor: Operator

2.8.3 Test Scenario

Select the * Create Contact List” Operation from the tool bar.

Review the tool selected dump windows on the timeline.

Verify that dump windows are placed in each X and K-band contact that is not a TDRS 275

contact following the sync point.

4. Verify that dump window start times and end times adhere to the following rules.

a. For TDRS Contacts — If the S -band contact starts more than 60 seconds prior to the K-
band contact, the dump window start time is offset 30 seconds from the start of the K-
band contact. Otherwise if the S-band contact start time doesn’t precede the
corresponding K-band contact by more than 60 seconds, the dump window start timeis
offset 90 seconds from the start of the S-band contact. The dump window stop timeis
offset 180 seconds before the end of the K-band contact.

b. For Ground Contacts — The dump window start time is 120 seconds after the start of the
X-band contact and the dump window stop time is offset 60 seconds before the end of the
X-band contact.

wnN e

2.9 Test Case: 9 Automated Sync Point Selection

2.9.1 Relevant Builds

This test case applies only to Build I1.
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2.9.2 Test Information

Goal in Context: The operator reviews the system selected synchronization point

Preconditions: The Scheduling Options must be specified and a contact list
Created and an SSR Buffer states report must be supplied.

Success End Condition: All buffer state entriesin the sync point offset window must be

present.
Failed end condition: All sync point entries are not available or none are displayed
Primary Actor: Operator

2.9.3 Test Scenario

=

After creating a contact list, the operator selects the “ Specify Selected Sync Point” option.

2. Verify that al buffer state entries in the sync point offset window are displayed in the sync
point parameters dialog.

3. Veify that the selected sync point is the latest contact before the start of the planning horizon
in which the buffers can be completely emptied.

4. Verify that none of the sync point candidates fall ina TDRS 275 contact.

5. Verify that the start times of the candidate sync points adhere to the following rules:

a. For TDRS Contacts— If the S -band contact starts more than 60 seconds prior to the K-
band contact, the dump window start time is offset 30 seconds from the start of the K-
band contact. Otherwise if the S-band contact start time doesn’t precede the
corresponding K-band contact by more than 60 seconds, the dump window start timeis
offset 90 seconds from the start of the S-band contact. The dump window stop timeis
offset 180 seconds before the end of the K-band contact.

b. For Ground Contacts — The dump window start time is 120 seconds after the start of the
X-band contact and the dump window stop time is offset 60 seconds before the end of the
X-band contact.

2.10 Test Case: 10 Generate a Schedule

2.10.1 Relevant Builds
This test case appliesto Builds | and I1.

2.10.2 Test Information

Goal in Context: The operator schedul es playbacks.

Preconditions: A contact list must be created and displayed on the timeline.

Success End Condition: The completed schedule is displayed to the operator on the
timeline.

Failed End Condition: The timeline remains unchanged. A dialog box is displayed
describing the error.
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Primary Actor: Operator
2.10.3 Test Scenario

Select the “ Generate Schedule” option from the menu bar.

Verify that each dump window contains a playback window.

Verify that the playback window is offset from the start of the dump window by the correct

amount.

4. Verify against aknown scenario (one of the provided test data sets) that the tool is correctly
calculating buffer full percentages, and playback durations.

5. Verify that the correct argument is placed in the Stn/Arg field for each PB_START event.
For dump window where no dump percentages are specified (PBFLEX) dumps, this value
will be the time between the start of the playback and the end of the corresponding dump
window to which it belongs. For dump windows that specify maximum dump percentages,
this value will be the user specified percentage for MODIS, MISR, and ASTER separated by
commeas.

6. Verify that the duration for each playback represents the time between the last playback start
and the current playback start.

7. Verify that the time specified in the TOT column represents the sum of the times specified in
the MOD, MIS, and AST columns.

8. Verify that for all FLEX playbacks the duration field on the playback stop event contains the
difference between the playback end time and the end of the dump window (safety margin).

9. Verify that any data that needs to be carried over to the next dump it specified in a

PB_Carryover event. Also verify that carryover amounts and durations are consistent with

those provided with scenario.

wN e

2.11 Test Case: 11 Create a New Schedule

2.11.1 Relevant Builds
Thistest case appliesto Builds | and I1.

2.11.2 Test Information

Goal in Context: The operator creates an empty schedule
Preconditions: The SPLAT tool must be running.
Success End Condition: A new blank scheduleis created.
Failed End Condition: The old schedule remains unchanged.
Primary Actor: Operator

2.11.3 Test Scenario

1. Select the “create new schedule” option from the tool bar.
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2. Verify that the tool raises a dialog box asking whether or not to save the current schedule.
a. Selecting “Yes’ causes another dialog to be displayed in which the observer can
choose the name and location of the saved schedule.
b. Selecting “No” causes the existing schedule to be deleted and a new schedule to be
created and the timeline cleared.

2.12 Test Case: 12 Customize Display/Print Layout of Schedule Data

2.12.1 Relevant Builds
Thistest caseisrelevant to Builds | and I1.

2.12.2 Test Information

Goal in Context: The Operator chooses which fields/events to display and/or print
and the order in which these fields should be presented.
Preconditions: None for customizing display of fields, However, a contact list

must be created to filter by event type.
Success End Condition: A schedule on the timeline or printed schedule reflecting the
ordering and field selection specified by the operator.
Failed End Condition: Incorrect fields are displayed or no fields are displayed at all.
Primary Actor: Operator

2.12.3 Test Scenario

The following variations should be tested:
1. Hide Columns (Fields) on timeline.

Select the Filters > Display Filter option from the Settings Menu.

In the Display Filter dialog, select the field option.

Select severa of the visible fields (for multi-select, selections must be contiguous)
and select the “Hide <<” button to move them to the available fields area.

Select the “ Save” option and verify that the columns (fields) are removed from the
timeline display.

2. Change the ordering of columns on the timeline.

Select the Filters > Display Filter options from the Settings Menu

In the Display Filter dialog, select the field option.

Select one or more contiguous fields in the available window.

Reorder them using the up or down options to move the selection up or down in the
availablelist.
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Select the “ Save” option and verify that the columns (fields) have been reordered on
the timeline.

3. Hide Event types on the timeline.

Enter scheduling options and create a contact list.

Select the Filters > Display Filter option from the Settings Menu.

In the Display Filter dialog, select the “Event Types’ option.

Select severa of the visible events (for multi-select, selections must be contiguous)
and select the “Hide <<” button to move them to the available events area.

Select the “ Save” option and verify that the Event types are removed from the
timeline display.

4. Hide Columns (Fields) in aprinted schedule.

Enter Scheduling Options

Create contact list

Generate playback schedule

Select the Filters = Print Filter option from the Settings Menu.

In the Display Filter dialog, select the field option.

Select severa of the visible fields (for multi-select, selections must be contiguous)
and select the “Hide <<” button to move them to the available fields area.
Select the “ Save” option.

Select the “Print Current Schedule” option from the tool bar.

Enter additional text if required and select the preview button.

Verify that the displayed schedule contains only the selected columns.
Close the schedule print preview.

5. Change the ordering of columnsin a printed schedule.

Enter Scheduling Options

Create contact list

Generate playback schedule

Select the Filters = Print Filter option from the Settings Menu.

In the Display Filter dialog, select the field option.

Select several of the visible fields (for multi-select, selections must be contiguous)
Reorder them using the up or down options to move the selection up or down in the
availablelist.

Select the “ Save” option.

Select the “Print Current Schedule” option from the tool bar.

Enter additional text if required and select the preview button.

Verify that the displayed schedule contains only the visible columns in the specified
order.

Close the schedule print preview.

6. Hide Event typesin a printed schedule.
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Enter Scheduling Options

Create contact list

Generate playback schedule

Select the Filters = Print Filter option from the Settings Menu.

In the Display Filter dialog, select the “Event Types’ option.

Select several of the visible events (for multi-select, selections must be contiguous)
and select the “Hide <<” button to move them to the available events area.

Select the “ Save” option.

Select the “Print Current Schedule” option from the tool bar.

Enter additional text if required and select the preview button.

Verify that the displayed schedule contains only the visible columnsin the specified
order.

Close the schedule print preview.

7. Hide and Reorder columns from timeline (Build 111 only)

Right click with the cursor over the time line column headers.

Check and uncheck column headings to hide/display the columns

To Reorder the columns, left click on a column heading and drag it horizontally left
or right to the appropriate position.

2.13 Test Case: 13 Edit Modeling Parameters

2.13.1 Relevant Builds
This test case appliesto Builds | and I1.

2.13.2 Test Information

Goal in Context: Operator changes parameter values affecting schedule generation
Preconditions: None

Success End Condition: Successfully modified set of modeling parameters

Failed End Condition: Modeling parameters left unchanged.

Primary Actor: Operator

2.13.3 Test Scenario

The following variations need to be tested:
1. Modify an Instrument Imaging Rate.

Select the “Modeling Parameters’ option from the “ Settings” menu.
Modify one or more of the instrument rates.
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Select the “ Save” option.
Generate a schedule and verify that imaging rate change is reflected properly.

2. Change the Superset capacity of SSR Buffers.

Select the “Modeling Parameters’ option from the “ Settings” menu.
Modify one or more of the buffer capacity settings.

Select the “ Save” option.

Generate a schedule and verify that buffer capacity is reflected properly.

3. Change the MODIS and MISR Night and Day offsets.

Select the “Modeling Parameters’ option from the “ Settings” menu.

Modify the settings for MISR and MODIS day/night offsets.

Select the “ Save” option.

Enter scheduling options and create a contact list.

Verify that MODIS and MISR day night events are offset the proper distance from
NADIR_TERM_CROSSING eventsin the Orbital Events Report.

4. Changethe PBFLEX dump time alocation priority.

Select the “Modeling Parameters’ option from the “ Settings” menu.

Select one or more of the entriesin “Dump Time Allocation Priority (PBFLEX)”
window.

Move the selection up or down to reorder the priority.

Select the “ Save” option.

Generate a schedule and verify that the dump time alocation priority has changed.

5. Modify the Playback offset from the start of a dump.

Select the “Modeling Parameters’ option from the “ Settings” menu.

Modify the playback offset setting.

Select the “ Save” option.

Generate a schedule.

Verify that playbacks are offset by the specified amount from the start of dump windows.

6. Modify the ASTER Automated Imaging Rate Settings

Select the “Modeling Parameters’ option from the “ Settings” menu.

Select the “ Aster Imaging Rates” Button

Modify one or more of the ASTER Auto Imaging Rates, changing which instruments are
used, and when they turn on/off.

Select Automated Aster modeling

Generate a schedule

Verify that changesto ASTER Imaging rateis reflected in schedule.
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2.14 Test Case: 14 Modify SPLAT Preferences

2.14.1 Relevant Builds
Thistest caseis applicable to Builds | and I1.

2.14.2 Test Information

Goal in Context: The operator changes the appearance of the SPLAT windows and
timeline.

Preconditions: None

Success End Condition: An Operator customized version of the SPLAT tool.

Failed End Condition: SPLAT default settings remain.

Primary Actor: Operator

2.14.3 Test Scenario

The following variations need to be tested:
1 Changethe SPLAT look and feel.

Select the “Preferences” option from the “ Settings” menu.

Select the “ General” Tab from the preferences dialog.

Select one of the available options for “look and feel” (Java Look and Fedl,
CDE/Moatif, Windows)

Select the “Ok” or “Apply” option.

Verify that look and feel of the tool has been modified according to the selection.

2 Display/Hide Advanced Fields on the Modeling Parameters Display

Select the “Preferences’” option from the “ Settings” menu.

Select the “ General” Tab from the preferences dial og.

De-select the “ Show Advanced Edits’ checkbox.

Select the “Ok” or “Apply” option.

Select the “Modeling Parameters’ option from the “ Settings” menu.
Verify that only buffer capacities are shown.

3 Set the Report and Saved data directories.

Select the “Preferences” option from the “ Settings” menu.

Select the “ General” Tab from the preferences dialog.

Select the “Browse” button next to the “ Report Directory” entry and select the
location for input reports.
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Select the “Browse” button next to the “ Data Directory” entry and select the location
for output.

Select the “ Ok” button.

Select the “ Scheduling Options’ option from the “File” menu.

Select the “ Select Reports’ option from the Scheduling Options Menu.

Select the browse button next to one of the input reports.

Verify that the default directory displayed in the open dialog is the one selected for
input reports.

Select input reports and scheduling options.

Create contact list.

Generate schedule.

Select “ Save Schedule as Text” option from the toolbar.

Verify that directory specified in save dialog box is the same as the data directory
specified earlier.

4 Sdect thetimeine event colors and font size.

Select the “Preferences’” option from the “ Settings” menu.

Select the “Timeling” Tab from the preferences dial og.

Change the font size.

Select the “ Choose Color” option next to one of the event types.

In the color selection dialog, select how to display the color (RGB, HSB, Swatches)
Select the appropriate color.

Select the “ Ok” option in the color selection dialog.

Select the “Ok” button in the Preferences dialog.

Verify that the font size has changed for entries in the timeline and that the event type
for which the color was modified now displays correctly.

5 Reset the SPLAT preferences.

Select the “Preferences” option from the “ Settings” menu.

Select the “ General” Tab from the preferences dialog.

Select the “Reset” button.

Verify that the input report location and data directory are cleared.

2.15 Test Case: 15 Print the Current Schedule

2.15.1 Relevant Builds
Thistest case appliesto Builds | and I1.
2.15.2 Test Information

Goal in Context: Operator prints the current playback schedule
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Preconditions: A generated schedule must be loaded/displayed on the timeline.

Success End Condition: A hardcopy of the current schedule, filtered per the selected
print filters.

Failed End Condition: No hardcopy is generated.

Primary Actor: Operator

2.15.3 Test Scenario

Select the “ Specify Scheduling Options’ operation from the tool bar.
Enter the scheduling options

Select the “ Create Contact List” operation from the tool bar

Select the “ Generate Schedule” operation from the tool bar.

Select the Filters & Print Filter option from the Settings menu
Modify the Print filters.

Select the “Print Current Schedule” option from the toolbar.

Specify any additional text in the provided field.

. Select the “Preview” button.

10. When the Print Preview is displayed, verify that the hardcopy contains al selected fields, etc.
11. Select the “OK” option from the tool bar or modify the print options.
12. Select “Print” when the printer dialog box is raised.

13. Retrieve printout and verify content/layout.

©COoONO~WNE

2.16 Test Case: 16 Save Current Schedule

2.16.1 Relevant Builds
Thistest caseis applicable to Builds | and I1.

2.16.2 Test Information

Goal in Context: Operator chooses to save the current schedule to disk.

Preconditions: A playback schedule must be generated.

Success End Condition: Ether abinary or textual representation of the current scheduleis
saved to disk.

Failed End Condition: The scheduleis not saved.

Primary Actor: Operator

2.16.3 Test Scenario

The following variations must be addressed:

1 Savethe schedule astext.
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Select the “ Save as Text” option from the main toolbar.

In the Save dialog box, browse to the desired location, and specify a name for the
saved report.

Select the “ Save” button.

Verify that schedule has been saved as text and that all events and fields are contained
inthetext file.

2 Savethe schedule as binary.
Select the “ Save Current” option from the main toolbar.
In the Save dialog box, browse to the desired location, and specify a name for the
saved report.

Select the “ Save” button.
Verify that schedule has been saved as “ xxx.splat”.

2.17 Test Case: 17 Test Red and Yellow Limits

2.17.1 Relevant Builds

Thistest caseis applicable to Build I11.

2.17.2 Test Information

Goal in Context: Operator modifies the Red and Y ellow limits and tests to see that
they are correctly applied during schedule generation.

Preconditions: A contact list must be created.

Success End Condition: A playback schedule with the red and yellow limits correctly
applied.

Failed End Condition: A playback schedule with incorrect red and yellow limits.

Primary Actor: Operator

2.17.3 Test Scenario

1. Theoperator selectsthe“Red & Yellow Limits’ option from the Settings Menu.

2. Inthe Limits Ul, the operator changes the Red and Y ellow Limits for one or more of the
buffers.

3. The operator selectsthe “ Save” button on the Limits Ul.

4. The operator selects the “ Generate Schedule” button.

5. The operator verifies that the generated schedul e reflects the red and yellow limit settings.

a. If the buffer full percentages do not exceed the limit settings, the operator modifies
dump window playback percentages in one or more preceding dump windows
causing enough carryover from one playback to another to force buffer usages beyond
[imits.
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b. The operator verifies that yellow and red limits are applied correctly during schedule
generation.

c. If abuffer usage exceeds alimit, the buffer usage column will be color coded either
yellow or red and the corresponding buffer “xxx_lim” field will have atext field color
coded accordingly with a text message indicating which limit was exceeded.

2.18 Test Case: 18 Manually Specify Sync Point

2.18.1 Relevant Builds
Thistest caseis applicable to Build 1.
2.18.2 Test Information

Goal in Context: Operator opts for amanually entered sync point.

Preconditions: A contact list must be created. Note the different scenarios for
cases with and without an SSR buffer states refprt

Success End Condition: The operator specified manual sync point is displayed on the
timeline and dump window shave been updated accordingly.

Failed End Condition: An error dialog explaining why the manual sync point was not
Added to the schedule.
Primary Actor: Operator

2.18.3 Test Scenario
The following variations must be addressed:

1. Candidate Sync Points loaded from SSR Buffer States Report

Specify an SSR Buffer States Report in the Input Reports Ul.

Select the “ Create Contacts’ option from the tool bar.

Review the schedul e to make sure candidate dump windows and a sync point have
been selected by SPLAT.

Select the “ Synchronization Points’ option from the tool bar.

Verify that al buffer state entries in the sync point offset window are displayed by the
dialog.

Select the “ Set Manual” button from the Synchronization Points Ul.

In the raised dialog, enter the desired time of the new sync point. Test severdl
variations where the times are in an outside of X and K band contacts. Verify that the
tool correctly identifies these cases.

Select the “ Ok” button on the Manual sync point dialog.

Verify that the specified manual sync point is displayed and selected in the list of
candidate sync points.
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Select the “ Save” button from the Synchronization Point Ul. Verify that the tool
displays a dialog box indicating the outcome of selecting a sync point.

Select the “Yes’ button to proceed. Verify that the sync point changes to the selected
time and that dump windows are updated to reflect the new sync point, and that all
playbacks are invalidated and removed from thetimeline. [Vvalid on for builds

| and Il. For Build Ill and beyond nodifications to dunp w ndows or
sync points causes an automatic schedul e regeneration. See test case
19].

1. No SSR Buffer States Report

Do not specify an SSR Buffer States Report when selecting input reports.

Select the “ Create Contacts’ option from the toolbar. Verify that the contact list
contains only events extracted from input reports. No sync point or dump windows
should be present.

Select the “ Synchronization Points” option from the toolbar.

Verify that the Synchronization Points Ul contains no candidate sync points.

Select the “ Set Manual” button in the Synchronization Points Ul.

In the raised dialog, enter the desired time of the new sync point. Test severa
variations where the times are in an outside of X and K band contacts. Verify that the
tool correctly identifies these cases.

Select the “Ok” button on the Manual sync point dialog.

Verify that the specified manual sync point is displayed and selected in the list of
candidate sync points.

Select the “ Save” option from the Synchronization Points Ul and verify that the tool
displays a dialog box indicating the outcome of selecting a sync point.

Select the “Yes’ button from the dialog window. Verify that the sync point is
displayed on the timeline and candidate dump windows are placed in al X and K
band contacts except K band 275 contacts.

2.19 Test Case: 19 Automated Schedule Re-Generation

2.19.1 Relevant Builds

Thistest caseis applicable to Build I11.

2.19.2 Test Information

Goal in Context: Operator edits, adds or removes a dump window or selects another
sync point.

Preconditions: A contact list must be created.

Success End Condition: The timeline updates automatically to reflect the change.

Failed End Condition: Thetimeline doesn’t update correctly.

Primary Actor: Operator
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2.19.3 Test Scenario
The following variations must be addressed:

1. Operator adds a dump window to a contact

Select the“Add” button associated with aK or X band contact.

Specify the dump start and stop and any buffer playback percentages.

Select the “Add” button and verify that the dump window has been added to the
schedule, the schedule is regenerated and reflects the additional dump window, and
that the Status bar contains the following message “ SSR Playback Automation Tool:
Schedule Regenerated”.

2. Operator modifies an existing dump window

Select the “Edit” button for a specific dump window.

Change one or more of the dump window parameters.

Select the “ Save” button and verify that the changes to the dump window are present
on the timeline and that the schedule is regenerated reflecting the changes, and the
status bar contains the following message “ SSR Playback Automation Tool: Schedule
Regenerated”.

3. Operator removes a dump window

Select the “Edit” button for a specific dump window.

Select the “Delete” button in the Dump Windows Ul.

Verify that the dump window was removed from the timeline and that the scheduleis
regenerated reflecting the changes, and the status bar contains the following message
“SSR Playback Automation Tool: Schedule Regenerated”.

4. Operator selects a different sync point

Select the “ Synchronization Points’ option from the tool bar.

Click on the radio button associated with one of the available sync points.

Click the Save button and verify that the selected sync point is displayed on the
timeline and that the schedule is regenerated reflecting the changes, and the status bar
contains the following message “ SSR Playback Automation Tool: Schedule
Regenerated”.

5. Operator enters a sync point

Select the “ Synchronization Points’ option from the tool bar.

Click the “ Set Manual” button.

Enter the Sync point time. Verify that entering a value outside of aK or X band
contact causes an error dialog to be displayed.

Click the Save button and verify that the selected sync point is displayed on the
timeline and that the schedule is regenerated reflecting the changes, and the status bar
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contains the following message “ SSR Playback Automation Tool: Schedule
Regenerated”.
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